Cfomputer systems

Maost argavnisétians use cgmputer systems ta help
in the day-ta-dag{‘m ggﬁgment of their buslness.
These systems nead to be set up, canﬂgured any
maintained. As computers have became re @
powerful, the complexity of camputgr systems
increased, so there is a need for knmg/ledgeable":-ﬁ: 8

practitioners to undertake this waork. "%,9,

This unit will help you to learn about setting up,
maintaining and tailoring computer systems to meet

«a user’s needs. Computer equipment may need to
Be upgraded or new peripherals, such as printers or
scanners, added. Operating systems and application
software may need patching to fix a problem or to
add an enhancement. Latest versilons of security
software may need to be installed. The areas
covered by the unit will be of value to all, regardless
of whether you intend to become a desktap support
tBthnitian, programmer, network engineer or
systems analyst. l

E IT p ctitidhers may be asked to advise on the
@urchase of new computer systems. Modern -
samware makes increasing demands of the har re
needed to run it. Therefore, practitioners nqed
keep up to date with the latest develapmentg in
both hardware and software. They also need to be ‘
aware of the tools available to protect systems and

. keep them secure.
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'So you want to be a...

Support Analyst

My name James Stimpson
Age 28
Income £24,000

What does a support analyst do?

I support the company’s desktop computers,
laptops and mainframe computer

What are your day to day
responsibilities?

I set up all the new desktop
computers and laptops. 1
maintaining them and I am,
responsible for fault-finding
if they develop problems. I
do some software support,
particularly spreadsheets. I
also run SQL queries on the
mainframe.

What qualifications did you need?

After completing my GCSEs, I went to college
to complete a BTEC National Diploma in IT
Applications, I wanted to take a practical route
into the industry because I like to be ‘hands on’.
Some of my colleagues have degrees but there are
a lot of IT certifications that can be taken and a
lot of different routes into the industry.

What training have you had?

I got my first computer when I was ten years old. I
have always upgraded and maintained my own PC
and I enjoy using new gadgets and technology. My
first job was as a mainframe operator. I did that
for six years, and then moved into PC support. I
have been on a number of training courses, but
the most important training has been ‘on the
job'.

“Problem-solving
abilities and an
interest in new
technologies are

important??

What are the hours lik&?

I usually work from 9am to 6pm, but sometimes
the company needs me to work later into the
evening. Sometimes we need to work at the
weekend, when the office is quiet and we don't
have to worry about taking the
system down for a few hours,
If I work extra hours I get paid
overtime. It doesn't happen often
but you have to be prepared to be
flexible.

How good is the pay?

When I first stated work, pay was
fairly low; about £12,000, but it has gradually
improved and I now earn double that amount, I
could earn a lot more if I was prepared to work
in London or work as a contractor, but I like the
company and the people I work with so for now I
am more than happy top stay where I am.

What qualities do you think are
important for your job?

You need a lot patience and good people skills.
Obviously you need good technical knowledge as
well as the ability to solve problems and prioritise
your workload. It really helps to have an interest
in new technologies, which luckily I do.

How do you see your career progressing?
I still have a lot to learn and with further
training and after gaining some more on the job
experience I would like to get more involved in
the networking side of things.
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gadmg criteria
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In this unit there are three evidence activities that give you an opportunity to demonstrate youro

achievement of the grading criteria:

page 58 P1, D1

) —"r":
fF -« page 63 - P2, M2, P3, P4

page 71 P5, M3, M1, D2

To achieve a pass grade the
evidence must show that the
learner is able to...

@D explain the function of
+ the system unit components
and how they communicate

describe the purpose,
features and functions of two
different operating systems

—— demonstrate the
operation and explain the
use of two different software
utilities

R

@D describe the range of
available utility software

€ undertake routine
maintenance tasks in relation
toa PC

e wm -

Fable below shows what you need to do to gain a pass,
quahﬁcatlon Make sure you refer back to it when you are com _‘
you are meeting the criteria and what you need to do to fill in ga
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Computer systems

To achieve a merit grade the
evidence must show that, in
addition to the pass criteria,
the learner is able to...

@D explain and implement
the installation and
configuration of an additional
or replacement device

- P P

[ vz ] compare the features
and functions of two different
operating systems

€5 explain the effect of the
software maintenance activities
carried out on the performance
of a computer system

r-------------- g i Ry,

r knowledge or experience.

A )
)

To achieve a distinction grade
the evidence must show that,
in addition to the pass and
merit criteria, the learner is
able to...

@D cvaluate at least three
specifications for commercially
available computer systems and
justify the one most suitable
for use in a given situation

[ D2 justify the considerations
for selection in the upgrade of
an existing computer system




a Understand the
hardware components of
computer systems
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Main memory

Processing | [Ou

Backing store

Figure 2.1 The components of a8 cormputer systern

Regardless of their size, most computers perform
similar basic functions:

¢ Input - data and instructions can be input
into the computer using a number of different
devices, such as a keyboard, mouse, scanner or
microphone.

¢ Main memory - data and instructions are
temporarily held in main memory before and
after processing. This is sometimes referred to
as ‘temporary storage’

® Processing - the central processing unit (CPU)
takes the data and instructions from main
memory and processes them in some way,
for example, producing an image or a text
document, generating a sound or opening a web
browser.

e Qutput - once processing has taken place, data
can be output, for example to a printer, as
sound through speakers or to be viewed on a
screen monitor.

¢ Storage - some information may need to be
stored for use at a later date. This is sometimes
referred to as ‘auxiliary’ storage. Common forms
of storage include hard disks, USB memory
sticks (sometimes known as pen drives) and
CD-ROMs.

SYSTEM UNIT COMPONENTS

Processors and options

Computers contain a number of processors that
perform different tasks, but the term ‘processor
usually refers to the main processor, otherwise
known as a microprocessor, CPU or chip.

The microprocessor is an integrated circuit (IC)
that is located on the motherboard. It controls
the activities of the computer by interacting with
other components that are on or attached to the
motherboard. The microprocessor executes a series
of programmed instructions with four steps: fetch,
decode, execute and write back. This process
involves fetching program instructions and data
from memory, decoding them, executing them
and then writing the result back to memory. This
process is covered in greater detail in Unit 9,

The speed of the processor is measured by a system
clock as a number of operations or cycles per
second. Modern processors normally operate at
speeds measured in gigahertz (GHz). One gigahertz
is 1,000,000,000 cycles per second!

Key words

Integrated circuit - a small electronic circuit
Motherboard - the central circuit board of a computer

Fetch instruction

from memory

Execute
instruction

Decode
| instruction

Flgure 2.2 The fetch execute cycle

When building or upgrading a computer system,
it is vital to ensure that the microprocessor is
compatible with your motherboard.




Modern desktop processors

Two companies dominate the computer microchip market: Intel and AMD.

Table 2.1: Intel® and AMO rmicrochips

__________ ------------n__a---------a-ta.-tu:j\\

Semperon™ - competes with Intel Celeron D.

Celeron® - this is a cost-effective processor using
proven technology for home and small office
applications.

B el L L L e

Pentium® 4 - the series was launched in late 2000
and retired in 2006. It was the fixst major redesign
since the launch of the Pentium Pro in 1995. It
uses hyper-threading technology that allows the
processor to operate more efficiently when multiple
tasks are running.

Pentium® D - a series of chips was introduced in
2005 using two Pentium 4 processors on a single
chip. This allows multiple tasks to be split across
the two processors, giving improved performance
over single processor chips.

e o - e

Athlon™ 64 - competes with Intel Pentium 4.

Athlon™ 64 X 2 - first AMD dual-core processor.

Athlon™ 64 FX - aimed at gamers. Dual-core from
FX-60 onward.

Core™ 2 Duo - a new series of dual processors using
several new technologies to save power and increase
processor performance.

N Qi QiU S g L L

Key words The system case

Dual-core processor - a dual-core processor has Most of the component parts of a computer
two processors on the same chip handling data system fit into a system case. There are a number
simultaneously, improving efficiency of different styles of computer case available,

including desktop, tower and mini-tower designs.
Modern laptop processors
Some laptops contain desktop processors. These
are likely to use more power, reducing battery life

and generating more heat than processors designed
specifically for laptop use.

Table 2.2 Laptop processors

Pentium® M . Moblle Athlon™ XP-M

Celeron® M ! Mob1le Athlon™ 64

.................... berorsrwasreomwe s wee

Mobile Pentium® 4 | Mobile Semperon™

and 4M E_

.................... boscssoccasananaanans

Core™ Duo and ! Turion™ 64

Core™ 2 Duo ;

13{0 c.e_sf 9{3_ ________ .__:, ____________________ Figure 2.3 Oifferent types of case — desktgp and

E Turion™ 64 X 2 Duo tower

K i Core )




It is important to consider the needs of the user the motherboard or connected to it. It performs a
when purchasing the case. Will the computer sit number of functions:

on a desk or under it? Some cases are designed to
have a small ‘footprint’, meaning that they take
up less space on a desk than a standard desktop
computer. If you choose a small footprint case,
you will need to consider carefully the form factor o distributes power at the correct voltages from
of the motherboard and ensure that all your the power supply to all devices that require it
components will fit in the case. The amount of A
equipment you need to house inside the case may
determine the size of case you choose. It is also

® provides connectivity between the components
and the microprocessor so that they can
communicate with one another

provides connectors for external devices, such
as keyboards and mice

important to consider the position of the power ° co'ntains external ports for connecting video,
button and the accessibility of USB connectors. prnters, etc.
¢ contains expansion slots for attaching
Key words additional devices, such as network interface

Form factor - the physical size and shape of a device.
This term is frequently used in discussions about ®
computer cases and motherboards

cards, modems, soundcards, etc.

has slots for RAM and an area for plugging in
hard drives, CD-ROMs, etc.

Cases are usually purchased with a power supply Currently the ATX form factor is the most common
unit (PSU) and a pack of blanking plates, screws form factor for PC motherboards.

and mounts. The screws are used to hold devices,

such as network cards or CR-ROM, drives in place.

Mounts support the motherboard in the case. research ti-'P
lzzatl;llznzgszlates are used to cover holes in the rear There ave a lavge e { sther {orm

factors for motherboards. Fawiliarise
Yourself with the form factors that are
available and have been produced in the
past. A useful starting point for this
research is www.vaotherbo@rds.ovg.

¥
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Choosing a motherboard

Replacing the motherboard is a common upgrade
that can be made to a computer. However, a
number of questions need to be answered before
making a purchase.

¢ What will the computer be used for? Will it
need to do heavy-duty processing, such as game
playing, scientific calculations or video editing?

Fgure 2.4 A motherboard ¢ Are the processor and memory (RAM)

compatible with the motherboard? This can
The motherboard (or system board) is situated be checked by going to the motherboard
within the computer case. All of the essential manufacturer’s website. The purchase of
components that are involved in making a PC work both motherboard and processor need to be
correctly, including the processor, are either on considered together.



¢ What features are associated with the chipset (a
component on the motherboard)? The chipset
determines a number of essential features of
the computer, such as the type and speed of
the processor, the type and amount of memory
that can be installed and additional features,
such as whether integrated graphics and sound
are included. Knowing these features may help
to differentiate between otherwise similar
motherboards.

e Is the computer to be used for multimedia
applications? Many motherboards come with
integrated sound. If it will be used for this
purpose, it is important that the motherboard
includes a PCI Express slot to take a graphics
card.

¢ If you want to attach peripheral devices, how
many USB2 ports are there? Do you need
FireWire? '

¢ Will the motherboard fit in your existing case?

BIOS

The BIOS (Basic Input and Output System) chip is
situated on the motherboard of a PC and is vitally
important to the computer's operation. It can
usually be found by looking for a chip near to the
processor with a sticker or text on it. It is usually
a Flash memory chip (this means that the BIOS can
be upgraded using software, rather than having to
replace the chip).

The BIOS boots the computer, When the computer
is switched on, its first action is to copy itself

into memory. It always copies itself to the same
location in memory. The processor then begins to
run the BIOS instructions. This is known as the
booting process. It completes a power-on test
(POST) to ensure that all components are working.
It checks to see that all the devices listed in CMOS
are present and working. CMOS is a complementary
metal-oxide semiconductor chip that contains a
setup program that stores information about the
date, time, hard drive and memory configuration.
It has to be supplied with power constantly so
that the information is not lost. A small CMOS
battery (resembling a watch battery) is used. CMOS

provides a set of instructions that the processor
executes until the operating system has loaded. It
supplies routines that allow the operating system
to interface with devices such as the keyboard,
mouse and monitor. Once the operating system
has loaded, peripherals use programs called device
drivers to interface with the operating system.

Power supply

A computer needs a power supply to operate.

The power supply unit (PSU) is usually, but not
always, supplied when purchasing the computer
case. The power supply unit converts AC current
to the DC voltages needed to power a PC. The unit
also contains a fan that is used to cool the inside
of the case. The unit is able to regulate incoming
power to reduce electrical noise and power surges.
(Unfortunately the quality of the power we receive
in our home, school and office varies.)

The external power supply can be subject to spikes
or surges (higher than usual voltages), brownouts
(lower than usual voltages), blackouts (sudden
and entire loss of power), lightning strikes and
electrical noise (when your computer shares its
supply with other devices via an extension cable).
Over time, any of these events may cause damage
to your computer. Many organisations use surge
protectors to protect their equipment and invest
in uninterruptible power supplies (UPS) to avoid
damage to computer systems and disruption to
work in the event of a power blackout.

A Under no circumstances should you ever
attempt to open the power supply unit. It
contains capacitors and transformers that can
supply a deadly electrical shock. (Note that
there are also capacitors within monitors,
which should be treated with the same
caution.)

AR AT

Investigate the range of aninterruptible
power supply solutions and power surge
protectors that are available, /




The power supply unit has a number of connectors
so that power can be distributed to the components
of the computer.

Figure 2.5 The power supply unit and connectors

Currently there are two standards for connecting
power to the motherboard of desktop computers.
Older motherboards have 20-pin AXT power
connectors. Newer motherboards have 24-pin AXT
power connectors. It is possible to attach a 24-pin

Table 2.3 Paower Supply Connectors

s
20-pin
connector
(older
motherboards)

24-pin
connector
(newer
motherboards)

4-pin Molex
connector
(floppy drives,
standard hard
drives, CD-ROM
drives, fans, etc)

SATA connector
(serial ATA hard
drives)

ceseperseevepeblil Cowpelteeseeneenbcs s oeennssesbe oo e -
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power supply to a 20-pin motherboard using an
adapter, but you should not attempt to attach a
20-pin power supply to a 24-pin motherboard.

Fan and heat sink

Modern computer components, such as the
microprocessor, graphics processors, the chipset
and hard disks, can generate a build-up of heat.
This heat must be reduced to within the range
of safe operating temperatures. This is achieved
through the use of fans and heat sinks.

Fans

Fans are used to disperse heated air, replacing it
with cooler ambient air.

¢ PSU fan - this is a fan incorporated into the
power supply unit, which blows cool air across
the motherboard. If the power supply fan stops
working, the power supply should be replaced
immediately. It is important that the case is
closed if this cooling is to be effective.

e CPU fan - a CPU cooling fan should be installed
on any Pentium or higher microprocessor. It is
attached either to the top of the processor or
the top of the heat sink, depending on whether
a heat sink is used. Most motherboards have a
three-wire (power, earth and speed monitor)
CPU fan connector. If the fan rotates too slowly,
the processor could overheat and fail. The third
wire on the connector allows the motherboard
to monitor the speed. If it detects a problem,
the computer will shut down or not hoot, to
protect the processor.

o Qther fans - it may be necessary to add
additional fans inside the case, particularly
in tower cases where cards are mounted
horizontally. Other components, such as
graphics cards, may have their own fans to
disperse heat.

Heat sinks

Heat sinks are machined blocks of metal, usually
finned. The large surface area is used to disperse
heat. An adhesive may be used to attach the heat
sink to the top of the processor. Alternatively a
clamp may be used, with a thermally conductive




pad or gel to ensure good conductivity. Fan-cooled
heat sinks made of aluminium were common until
recently, but now many heat sinks are made of
copper or have copper bases. The fins on heat
sinks may become coated with dust, reducing their
efficiency.

Hard drive configuration and
controllers

The hard disk drive stores data. Hard drives are
contained in sealed units that contain one or more
disks, read-write heads and control electronics.
The disks are made of aluminium and coated in
ferro-magnetic material or a mixture of nickel

and cobalt. Each disk contains an upper and lower
platter. Modern drives come in two main sizes: 2.5
inch and 3.5 inch. The smaller drives tend to be
more expensive and are used in laptops.

Key words

o e e o o o = e P P W

Read-write heads - mechanisms that read data from or
write data to disk drives

Flgure 2.6 A hard disk

Hard drives are installed in the computer case and
connect to the motherboard. When more than one
hard drive is installed, one is designated as the
controlling or master drive; the other is known as
the slave.

External hard drives can also be purchased. These

Research ti,p

nvestigate the sizes and speeds of har
drives available today by looking at
manufacturer websites such as:

o Www.wolc.com

o www. hitachi.co.uk

o WWW.Senonte.com.
9

/
The microprocessor communicates with other
devices, such as hard disks, printers and monitors,
through controllers. Sometimes the controller
is built into the motherboard, but it can also be
contained on a card that slots into the motherboard.
It translates signals and protocols between the
system and its I/0 (input/output) devices. Several
different types of controller are available.

IDE

IDE (Integrated Drive Electronics) drives (or ATA
drives) are a computer bus technology used for data
transmission from hard drives and optical drives. It
uses 40 wire ribbon cables to connect a hard drive to
the motherboard. The ribbon cable has two or three
connectors attached to it: one to attach to the
adapter and the others to connect to the drives. IDE
has been used mostly as an internal computer device
as the standard only allows for cables with a
maximum length of 46 cm (although longer cables
are possible). If two drives are connected to a cable,
one is set up in the BIOS as the master drive. The
second is known as the slave drive.

EIDE

EIDE (Enhanced Integrated Drive Electronics) offers
higher performance than IDE, as it supports data
transfer up to four times faster (up to 16.6Mbps)
and can also support larger storage capacities. The
technology can support other devices, such as CD-
ROMs and CD Writers. A later development of EIDE,
called Ultra-ATA, can support data transfer rates of
33Mbps.

Key words

are standard hard drives that have been encased in

a caddy. USB connectors are used to connect it to
the computer. They are used for additional storage
or to back up data held on the computer.

Computer bus technology - a collection of wires
through which data is transmitted from one part of a
computer to another




SCSI (Small Computer System Interface)

The SCSI standard has been around since 1986,
but further improvements have been made since
then. It has traditionally been used for attaching
multiple hard drives to high-end workstations
and servers. It is also used because of the device's
speed at transferring data.

An adapter card is used to connect the SCSI
devices to the motherboard. An adapter can
support up to fifteen devices. Each SCSI device has
its own controller. These are intelligent and handle
data transfer operations, freeing up other system
resources, including processor time, that would
otherwise be used for this purpose.

SCSI devices may be internal to the computer

or external. If they are external, they use a

thick shielded cable with Centronics-50 or DB-25

connectors to connect the devices. Multiple SCSI

devices can be daisy-chained (wired) together. If
the device is internal to the case, it uses a 50-pin
ribbon cable. Other SCSI devices include printers,
scanners, optical and tape drives.

SATA (Serial Advanced Technology
Attachment)

SATA has been developed as a replacement for
older ATA standard. Data can be transferred much
faster using serial transmission. The connectors
and cabling used are very different to ATA ribbon
cables. Each drive has its own thin cable and it is
possible to hot-swap drives, which was impossible
to do using ATA. The connectors are grooved,
ensuring that they can only be connected one way.
SATA transfers data at speeds from 150Mbps and
there are plans to increase this up to 600Mbps.

Key words

hot swap - the ability to remove and replace
components while the computer is operating

.-

There is continued rising demand for small, high :
capacity hard drives. In January 2007, Fujitsu i
announced a breakthrough in magnetic storage i

h

technology that could enable storage capacities of a
terabyte per square inch to become a reality. ;

..............

Ports

Parallel and serial ports

A parallel port is a type of connector found on
older PCs. They were mostly used to connect
printers, zip drives and some scanners, but have
been largely superseded by USB ports. Another
form of connector found on older PCs is a serial
port. These were used to connect mice, joysticks,
keyboards and other peripherals to a PC. They have
also mostly been superseded by devices using USB
connectors.

USB (Universal Serial Bus)

USB is a connection technology that can be used
to connect up to 127 devices to a computer. It
is primarily intended for slow devices, such as
keyboards, mice, joysticks and external hard
drives. USB is designed to be Plug and Play: it
should be possible to attach and detach USB
devices while the computer is running. The
standard specifies two types of connectors and
receptacles: series-A and series-B. Series-A
connectors are designed for devices such as mice
and keyboards; series-B connectors are designed
for scanners, and printers.

__________________________________________

i Think There are two standards for USB:
H USB1.1 and USB2.0. Find out what the
:‘ differences are.

__________________________________________
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Firewire is a high-speed technology that allows
data to be transferred between digital devices,
such as digital camcorders and some digital
cameras. It was developed by Apple, but is also
used with PCs. Many new desktop computers and
laptops come with Firewire ports built in, but
Firewire cards can be purchased for older systems.



Peripherals

Peripherals are pieces of optional hardware that can
be added externally to expand the functionality of
the computer. Common peripherals include printers,
scanners, plotters, webcams and digital cameras,
and will be looked at in more detail in the following
section.

Printers

Three main types of printer are available: dot
matrix, inkjet and laser printers.

¢ Dot matrix printers - these have a print head
that moves back and forth across a sheet of
paper and print by striking an inked ribbon
against the paper. The letters are formed from a
matrix of dots. Some models can be very noisy
and they vary greatly in quality of output,
speed and price. Very fast dot matrix printers
are often used when reports containing large
amounts of data processing need to be printed
quickly and regularly.

® Inkjet printers - these are very popular as they
are relatively inexpensive to purchase, easy to
use, quiet and produce good quality output.
Most work by producing pulses of current which
propel heated droplets of ink onto the page. The
ink is water-based and can smudge if handled
too quickly after printing or if exposed to water.
They contain one or more disposable cartridges
of ink, which hold only small amounts of ink
and need to be replaced frequently, which can
be expensive, particularly for colour printing.
Print heads can clog with ink if the printer is
not used regularly.

¢ Laser printers - these produce high-quality
output. They used to be much more expensive
that inkjet printers, but there are now many
cheaper models developed for the home market.
A laser printer temporarily saves print-job data
to its own memory. Some models are able to
make use of the memory within an attached
computer. The printer contains a drum made of
photoconductive material. The drum receives a
positive electrical charge from either a corona
wire or a charging roller. As the drum rotates,
a laser passes across its surface, drawing (as a
pattern of negative electrical charges) the letters

or images to be printed. Toner (a fine positively
charged black powder) coats the drum, adhering
to the negatively charged areas. A sheet of
negatively charged paper rolls under the drum.
The toner is transferred to the paper, which
then passes between two hot rollers, known as
the fuser. The toner melts and bonds with the
paper. After the toner has been removed, the
drum passes a discharge lamp. This removes the
electrical charge from the drum, so that the
process of printing the next page can begin.

.............................................

The development of new printer technologies tend to
be evolutionary rather than revolutionary, involving
improvements in existing types of printer. Ricoh have
recently developed a range of gel-based printers. The
gel dries instantly on contact with paper, reducing
smearing and bleeding that can occur with inkjet
printers. Revolutionary new products are less
common. Xerox is presently developing an inkless
printer that uses reusable paper.

______________

Scanners

Scanners are devices that can analyse an image or
text and save it as an image. The most commonly
used type is a flatbed or desktop scanner, but
hand-held and rotary scanners are also available.
To scan a document, it is placed face down onto

a glass plate. The scanning program needs to

be opened and selected, such as the area to be
scanned. When the scan is completed, the image
is saved. When installing a scanner, accompanying
software, including drivers, needs to be installed.

Plotters

A plotter is a device used to create line drawings
by means of a pen or pencil attached to a
mechanical axm. Plotters are frequently used in
engineering and architecture to produce very
precise drawings, which can be very large. The
colour of pens can be changed to produce multi-
coloured drawings. Many are being replaced with
very large format inkjet and laser printers. In some
plotters, other tools, such as cutters, can replace
pens on the mechanical arm and vinyl can replace
paper. Patterns can then be cut by the device.



Webcams

A webcam is a camera that is able to capture and
send real-time images across the internet. The
webcam is attached to a computer, usually facing
the user so that images of the user can be sent

to another computer. This will require additional
software, some of which is freely available as a
download. Webcams may also be used for other
purposes, including security. Software is available
that will activate and record sound and movement
when it is detected. Webcams are often positioned
over busy roads, allowing internet users to check
road conditions before travelling. Webcams are also
used to show the weather in different locations.

Digital cameras

Many digital cameras use flash memory cards to
store the pictures taken. It is easy to transfer
images taken by most modern digital cameras

to a computer using a USB cable. Once saved on
the computer, image manipulation software can
be used to edit the images, if required, before
printing. Alternatively, memory card readers

can be purchased for PCs, removing the need to
connect the camera to the PC via a cable. Some
photo printers have memory card readers built in.

Internal memory

Computers need to be able to store data and
instructions temporarily while processing takes
place. In PCs, three types of memory need to be
considered: RAM, ROM and cache.

RAM (random access memory)

This memory is situated on the motherboard, close
to the processor. It consists of modules that are
inserted into slots on the motherboard. They can
be removed or replaced as necessary. At the time
of writing, most PCs have 512MB or 1GB of RAM,

Figure 2.7 RAM rnodule

Instructions and data are read from and written to
RAM from the processor. RAM is sometimes known
as ‘primary or main memory and is vital to the
operation of a computer. It is volatile, meaning
that when the computer loses power or is switched
off, the data held in RAM is lost.

Data held in RAM can be accessed quickly using
its memory address. This is much faster than
serial access, such as from tape, or access from a
hard-disk drive (which requires read/write heads
to move to the location where the data is stored
before it can be accessed). However, with the
development of faster processors, the time taken
to access data stored in RAM has become an issue:
it has created a performance bottleneck.

At the time of writing, the most common types of
RAM are DDR and DDR2 memory.

¢ DDR SDRAM (double data rate synchronous
dynamic random access memory) - these
memory modules operate at twice the speed
of the earlier SDRAM. They had 168 pins and
are not interchangeable with the newer DDR
modules with 184 pins. DDR RAM cannot be
installed on motherboards designed for SDRAM.

e DDR2 SDRAM - this is superseding DDR SDRAM.
It operates in a similar fashion, but with higher
bus speeds, reducing system latency time. It
has lower power consumption and operates at a
lower temperature than DDR SDRAM.

Key words

System latency time - the length of time between

transmitting and receiving data

ROM (read-only memory)

ROM is a hardware chip used to store BIOS
information. It is sometimes known as ‘firmware’.
ROM is non-volatile, so it maintains the
information it holds, even when the computer is
turned off. It consists of permanent instructions
used when a computer is booted.




Cache

This is very fast RAM that operates in conjunction
with the processor. It temporarily stores the most
frequently accessed data and instructions. When
the processor operates, it looks for data in the
cache prior to looking in RAM. Cached data and
instructions can be accessed more quickly than
data and instructions that have to be fetched from
main memory.

Memory caches built into the microprocessor are
called Level 1 (L1) caches. They are usually 32KB
in total, divided into two 16KB memory caches:
one for data and one for instructions. (AMD K6
processors use 64KB of L1 cache). Many modern
PCs also have a further cache, called Level 2 (L2).
L2 cache is usually 256KB or 512KB, and is located
on a separate chip. If the processor cannot find
the data it is looking for in L1 cache, it will look
in L2 and then in main memory.

Specialised cards

Cards (also known as expansion boards), are
printed circuit boards that can be added to provide
increased functionality.

Network interface cards (NICs)

Networks can now be found in many different
locations, including the home. A network can
range from two computers linked together to
networks of large numbers of computers.

An NIC allows a computer to communicate

with others on a network. It slots onto the
motherboard, although some motherboards have
NIC circuitry built in. An NIC converts the parallel
data stream used by the computer to serial data
packets used by a network. It comes with either
PCI or ISA connectors, depending on the type of
slot it is to be positioned in on the motherboard.
It also comes with either BNC or RJ45 connectors,
depending on the cabling being used. Software
drivers need to be installed on the computer to
complete the installation.

NICs can also be used to network printers. Without
an NIC, if you want two or more computers to
share a printer, one computer needs to act as a
host. This computer would have to be switched on
for the other to be able to use the printer. Some
modern printers come with network capability
(NICs) built in. These are slightly different from
the NICs discussed above, as they have a processor
built in to manage the tasks that the software
drivers perform on a computer. The NICs tend to be
proprietary (the property of a company) and are
usually manufactured by the maker of the printer.

Graphics cards

For high-end gaming and processor-intensive 3D
graphics rendering, separate graphics cards are
usually required. A graphics card performs three
main tasks: geometry, lighting and rendering
images. Geometry involves the computation of
shapes, lighting involves the creation of shadows,
and so on, and rendering involves adding textures
to surfaces.

There are two sorts of graphics cards - AGP or
PCIe. AGP is slower and is being phased out.
Motherboards come with either an AGP slot or
PCIe slot(s). An AGP card cannot be installed in

a PCle slot, so it is essential that you check that
you have a matching motherboard and graphics
card. For high-end processing, it is possible, using
PCle slots, to install two different graphics cards
in a PC. This allows complex processing to be
shared across both cards. This also allows up to
four monitors to be attached to a PC (an operating
system that supports multi-monitors, such as
Microsoft Windows® XP is also required).



Graphics cards have a number of components:

e A GPU (graphics processor unit) - this dedicated
processor is designed to process complex graphics
algorithms quickly. It therefore reduces pressure
on the main processor.

e Memory - a graphics card has its own dedicated
memory.

e RAMDAC - this is an additionat chip found on
graphics cards that converts digital signals from
the GPU to analogue signal to be output to the
monitor.

BACKING STORE

Different technologies have been used to develop
devices that can store programs and data on a
more permanent basis than the expensive and
volatile main memory allows.

From the early days of computer systems, the use
of magnetic storage systems, such as hard disks,
floppy disks and tape, has been common. More
recently, mainly due to the development of pen
drives, most new computer systems have stopped
shipping with floppy disk drives.

Types of backing store

Disks

A floppy disk is a portable storage device. It is a
circle of Mylar, encased in a plastic rectangular
sleeve. The most common version is the 3.5 inch
floppy disk, which can store 1.44MB of data.

Most new desktop computers and laptops now ship
without floppy-disk drives as many computer users
now use much higher capacity USB pen drives to
move files from one computer to another.

Pen drives

These devices, sometimes known as USB Flash
Drives, have largely replaced floppy disks as the
portable storage device of choice. At the time of
writing, they can be purchased in a wide variety of
sizes from 128MB to 8GB.

These devices use Flash memory. This is non-
volatile, erasable and rewritable memory. It offers
fairly quick access times and is more resilient to

Figure 2.8 A pen drive

knocks than disks. The number of times you can
erase and then rewrite to the device is limited,
however. Data is erased in blocks (blocks of data
make up files). Most available Flash memory
devices are guaranteed to last for at least one
million rewrites. Chip firmware or system drivers
spread the rewrites between sectors so that
certain areas of the device do not wear out before
others. This is called wear levelling. Bad blocks, ie
corrupted data, are also rempved from use.

Optical media

A CD-ROM (Compact Disk Read-Only Memory)

is a disk composed of a polycarbonate, covered
with one or more very thin layers of reflective
metal, usually aluminium, which is then coated
with lacquer. CD-ROMs are designed to store text,
images and stereo sound. Data is encoded onto the
CD starting at the centre and finishing at the outer
edge. A CD can hold 650MB or 700MB of data.

The data held on a CD-ROM is read by a drive using
laser light to read the pits and lands on the CD as
it rotates. (Pits are etched onto the CD when it is
produced. Lands are the areas on a CD between the
pits). The reflection of the laser light away from
the surface of the disk is detected by a sensor. The
sensor converts the signal into digital signals that
can be interpreted by the computer.

A DVD is another type of optical storage disk and
can store between 4.7 and 17GB of data. The disks
resemble CDs, but store data using a different
format and at a much higher density. DVD drives
are backwardly compatible with CD-ROMs.

There are a number of different recording standards
and you need to ensure that you purchase disks
that are compatible with your DVD drive and/or
DVD player. The most commonly used formats are:

¢ DVD-R and DVD-RW - DVD-R was the first format
(non-rewritable) that could be played on DVD



players. It is compatible with most, but not

all DVD players and DVD-ROMs. DVD-RW is a
rewritable format that can be played on slightly
fewer DVD players and DVD-ROMs.

® DVD+R and DVD+RW - DVD+R was developed
later and considered more reliable, Cheaper DVD
players are more likely to play DVD-R disks.
There are many hybrid DVD players on the
market that will play both formats.

DATA TRANSMISSION
Buses

All of the main computer components
communicate with each other via collections of
wires called buses. There are a number of different
types of bus to consider:

¢ Data Bus - this carries data between the
processor, main memory and peripheral devices.
When the processor wants to read or write data,
an address is sent along the address bus and the
data is transmitted.

¢ Address Bus - this carries addresses of memory
locations between the processor and main
memory. It is used when data needs to be read
from or written to memory. The number of lines
that make up the bus determine the number of
memory locations that can be addressed.

e Control Bus - this carries commands from the
processor to other devices and status signals from
other devices to the processor. It coordinates the
activities of the computer system.

Microprocessor Control

Eg @ N
Unit 32 wires
—

32 wires £ Address =

Memory

32 data
inputs

Figure 2.10 Bus system

Expansion Bus (I/0 Bus)

o ISA (Industry Standard Architecture) - this is
an obsolete, slow bus system used by early
8-bit and 16-bit PC systems. It appeared initially
in 1981 and hung around for twenty years. It
was used to connect peripheral devices, such as
modems and sound cards. It could be difficult to
configure the devices, eventually leading to the
development of ISA PnP, otherwise known as
Plug and Play.

¢ EISA (Extended Industry Standard Architecture)
— this is a 32-bit version of the ISA bus
architecture. It was introduced in 1988 as an
alternative to IBM's Micro Channel architecture.
It is possible to plug an ISA card into an EISA
slot.

e VESA Local Bus (Video Electronics Standards
Association) - this was developed in the late
1980s from the need to have a bus that could keep
up with faster processors. It was used mainly for
video and sound cards. It had a 32-bit data path.

o AGP (Accelerated Graphics Port) - developed
by Intel for the demands of 3D graphics. It
creates a dedicated channel so that the graphics
controller can access main memory directly.

e PCI (Peripheral Component Interconnect) -
developed by Intel (1993). PCI supports both 32-
bit and 64-bit systems. It also supports both ISA
and EISA. It replaced the VESA Local Bus. It is
common to see PCI expansion slots alongside the
new PCI Express slots in modern motherboards.

e PCI Express — designed to replace PCI and AGP
and still being developed and improved. It
has its own expansion slot(s), different to the
earlier PCI or PCI-X slot. It is far faster than
previous bus architectures.

Research tLp

lnvestigate the range of speeds of data
transter achieved by the different bus
architectures described above. Wikipedia,
processor or motherboard manufacturer
websites are a good starvting point.




Modems

Modems are used to connect a computer to the
internet. A modem takes a digital data signal
from a computer and turns it into an analogue
signal (sound) so that the data can be transmitted
along a telephone wire. When the signal reaches

a recipient computer, its modem converts the
analogue signal back to digital. Modems can be
internal or external devices and most transfer data
at 56Kbps. There may be a few older modems still
in use that transfer data at 28.8 or 14.4Kbps.

ADSL (Asymmetric Digital Subscriber Line) allows
data communication over telephone wires at a
faster speed than that achieved using a standard
modem. Both voice and data can be sent at the
same time,

Cable modems are not strictly modems as they do
not convert digital signals to analogue. They are
used to provide a broadband service using spare
capacity on a cable television network.
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The internet is playing an increasingly important
role in business. In 2005, 70 per cent of UK
businesses had a website, 31 per cent had an
intranet, and 8 per cent an extranet. The proportion
of businesses buying or selling products over the
internet doubled between 2002 and 2005, from 7
to 15 per cent, whilst the value of internet sales in
2005 hit £103 billion.

______________

Processor speed

It is possible to run a CPU at a higher speed

than it was designed for by increasing the bus
speed to a higher speed than recommended or by
configuring the motherboard for a faster processor.
This may result in a slight improvement in the
processor’s performance. However, it will certainly
void your warranty and is not recommended by the
major chip manufacturers.

e e e e

CONSIDERATIONS FOR SELECTION
Cost

It is possible to purchase a general purpose
computer for under £500. If the computer is going
to be used to run the latest computer games or for
video editing, a high-end computer with a very fast
processor, lots of RAM, a dedicated video card with
considerable on-board memory, and a large hard
drive will be required. This may cost £1500 or more.

New computer systems come with a warranty and
this should be looked at carefully, considering:

¢ how long it will last
¢ whether it covers both parts and labour

¢ whether the equipment needs to be returned to
base

¢ who will pay for the postage?

¢ if on-site repair cover is a next day service.

User requirements

There a number of considerations when making a
decision about which computer to buy:

e What will the computer be used for? The
specification required for a computer to be used
for video editing will be very different to a
computer to be used for browsing the Internet
and running office applications.

¢ Is a maintenance contract required? These can
be purchased from equipment manufacturers
and third-party vendors. As with warranties,
different types of contracts exist. The most
expensive are 4 X 4 contracts for servers, which
guarantee that an engineer will arrive within
four hours and that a fix will be in place within
four hours. If the equipment cannot be fixed
within this time frame, the vendor will supply
replacement equipment until yours is repaired.

e What other peripheral devices need to be
purchased at the same time? If there are very
specific requirements, such as a printer needing
to print a certain number of pages per minute,
then these need to be specified very carefully to
ensure that they meet requirements.



® Does the system need to be compatible with In addition, the Microsoft Windows® XP operating
other systems? For example, if it is to be used system has a number of accessibility options built
for video editing, the computer will need a in, such as:

FireWire port. You should also consider how
many USB ports are needed and whether they
are easily accessible.

e high contrast to improve the screen contrast
using alternative colours and font sizes

¢ toggleKeys, which emit sound when pressing

i ?
e How much storage is needed and what type? caps lock, scroll lock, and num lock

Programs and data are normally stored on the

hard disk, so this needs to be large enough to * soundSentry, which gives visual warnings for
meet the needs of the user. Additional external system sounds
hard drives can be purchased, but these tend to * option to improve visibility of the mouse
be more expensive and vulnerable than those pointer
installed internally. Is a DVD rewriter needed?
® magnifier
Accessibility for disabled users * narrator text to speech program

. - . . ® on-screen keyboard.
A wide range of assistive devices and software is v

available to assist users with disabilities. These
include: e

® Draille keyboards, large keyboards and keyboards

with high contrast key-top stickers :
i Examples of software to assist users with reading

and writing difficulties includes Dragon Naturally
Speaking, a voice recognition software; TextHELP

o large monitors Read & Write, where text can be spoken back as it is
typed; Supernova, which combines speech reading
with a magnifier; and CCTV, a magnifier.

¢ trackerballs, head-mounted pointers and
adaptive joysticks

® gspeech recognition software

® screen readers.

______________

Research tip
Wwhat computer devices have been
developed to atd users with phgjs’wm
disabilities? A good stavting polnt for
your Lnvestigation is

A OacclLct 7
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Figure 2.11 A braille keybosrd
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CASE STUDY: DATA-PRO LTD PART 1: HARDWARE
RESPONSIBILITIES

_________________________________________________________________________________

Data-Pro is a multinational company involved in
data processing at a number of different locations.
At one particular location, the PC Support Team
has three technicians and a team leader. They are
responsible for supporting 250 users, 250 PCs, 40
laptops, 40 printers and 18 servers. The team has
a wide variety of responsibilities, involving
hardware, software and maintenance.

The technicians are frequently required to:

e upgrade hard drives, memory and graphics
cards

e install and configure dual-screen video cards,
scanners, local and network printers.

The organisation operates a help-desk system.
Calls for IT-related problems are recorded
centrally via a service desk team onto the
company’s help-desk software, TouchPaper®.

Calls are assigned a priority level between 1
and 5 and are then assigned to the appropriate
resolver group: hardware support, network
support, server support, mid-range support or
mainframe support. There is some overlap of
responsibility between these teams. The priority
level is based on the severity of the problem:

o level 1is the highest priority. The team has
4 hours to resolve a Level 1 call. It usually
involves a full outage affecting a significant
number of users, who are unable to continue
working until the problem is solved.

e A Level 3 call is an issue or problem. Three
days are allowed to resolve this.

e A level 5 call is a change request. It might be
an installation of new software, procurement
of new equipment or a machine move. Ten
days are allowed to complete a task like this.
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When the call has been completed, it is resolved
with a resolution description typed into
TouchPaper®, The call returns to Service Desk for
final closure.

The hardware team:
e troubleshoot hardware problems
e repair hardware that is out of warranty

® manage repairs to hardware that is in
warranty, ringing the manufacturer’s service
line, describing the problem, arranging an
engineer visit and ensuring that the problem
is fixed

® move computer equipment. The team liaise
with the facilities department for floor-box
moves or desk moves, the network team
if additional networking is required and
the communications officer if telephone
connections need moving

e specify, procure, install and support servers.
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Evidence activity

P1-D1

You have been employed by a college to support
their computer systems.

1. Your line manager has asked you to produce a
presentation that explains the function of system
unit components to new computing students.

It is important that the use of jargon is kept to

a minimum and that all terms are defined. The
presentation could include diagrams with hotspots
or hyperlinks to slides containing details and
examples. You must ensure that you include details
of how the components communicate. (P1)

2. The college has asked you to specify three
different computer systems for the college:

® a computer to be used to run Office
applications, web browser and email

e a computer to be used by the media studies
department for video editing

® a computer to be used by the engineering
department to run a CAD program.

Produce a report making three different
recommendations for each of the computer systems
required, with an appropriate output device also
selected. Decide which system is most suitable

for each situation, considering cost and technical
requirements, and justify your choice. (D1)

a Understand the
software components of
computer systems

OPERATING SYSTEM SOFTWARE

The operating system (0S) of a computer is a
program, or suite of programs, that controls the
operation of the computer. It acts as an interface
between the hardware and software applications.

Operating system examples

There are a number of different operating systems
available for computers, The most common are:

e Microsoft Windows® - this is a very widely
used operating system. The latest version is
Vista. Previous versions include XP Professional
and Home, 2000, 98, NT, ME and 95. Microsoft
Windows® is designed for use on home and
business PCs and laptops. Historically, it
was designed for use on single-user systems.
Microsoft Windows® XP is a multi-tasking
operating system developed from the earlier
NT kernel. It incorporates both a graphic user
interface (GUI) as well as a command line
interface (cmd.exe). Microsoft Windows is
thought to be easy to learn to use.

e TUNIX® - Unix is a multi-tasking, portable multi-
user operating system. It has been developed
since the 1960s by many different corporations
and individuals. It has a hierarchical directory
structure. The operating system consists of a
kernel that manages hardware and data access,
schedules tasks and enforces security. It has a
shell that supports custom environments for
users and executes user commands. A large
number of utilities are available for process,
user, print and file management. Unix has
traditionally been viewed as more difficult to
learn to use than Windows, due to its command
line interface. Many Internet servers are UNIX-
based.

Key words

Portable - can be used on a computer system that is
different from the one for which it was designed




¢ Linux - Linux is a multi-user 0S that will run on
a number of different computer architectures,
including PCs. It is similar to UNIX, but requires
less hardware resources to run. It is Open Source
software, which means that anyone can have
access to the source code, Examples include Red
Hat and Fedora.

e Mac OS - This GUI 0S was developed for use
with Apple Macintosh computers. Early versions
operated only with Motorola 68000 systems, but
later versions were compatible with PowerPC.
The latest versions are compatible with Intel
x86 architecture.

Research tip

tt ts bmportant that you become
familiar with the fundamentals

of UNIX and Windows. There are
some good tutorials available online,
ineluding: ‘

vy ERCWRATE g nsr
o WWW.LL.SHITCL.OC. 1R/ Teachlm@ /LAnLx
LI (]
12
o WwWW.microsott.com/windows/ustng/
[

- ] a0 Iy $= a7l ety
wilno {‘“.”/J/\'P /g et wlt. ‘/vl,:F 5

Command line and GUI operating
systems

Command line interface

The command line interface is text-based and
relies on users typing commands onto the screen
from the keyboard. UNIX shells and DOS both use
this type of interface.

It is possible to access the command line in
Microsoft Windows® XP by clicking the Start button,
clicking Run and typing emd. This opens a window
with the DOS prompt. To see a list of files and
folders, type dir at the command prompt (where
the cursor is flashing). If there are too many folders
and files to fit on one screen, type in dir/p. This
will allow you to view the first screen, and then
press the spacebar to see the next screen until you
have viewed all the files and folders. Alternatively,
you could type in dir/w to see the files and folders
using a wide format. At any point, you can go to
the root of the C drive, by typing cd\.

The command line interface is very quick to use
when the correct commands are known, because
the user does not have to work their way through
menus or click through a number of selections
with a mouse. It does not require Windows, uses
less memory than a GUI and will run on a very
basic PC and monochrome monitor. However,

it relies heavily on a user’s typing skills and
knowledge of commands.

Batch files

It is possible to write multiple commands into

a text file. This is very useful, particularly for
procedures that need to be repeated frequently.
The file is saved with a .bat extension. It can be
scheduled to run at specific times of day, or when
specific events occur, such as when a PC boots or
shuts down.

Graphical user interfaces (GUIs)

This interface allows users to interact with the
computer using windows, icons, menus and a
pointing device (WIMP). Microsoft Windows®, Mac
0S and X Windows (Linux) all use variations of this
type of interface.

The interface consists of ‘widgets’ that allow the
user to interact with the program, including
windows, scroll bars, buttons and menus. Large
widgets, such as windows, are containers for
content. One of the features of a well-designed
GUI is that the widgets are customisable, allowing
the user to adjust the layout of the interface to
suit their method of working. GUIs are described
as intuitive or easy to use (although some might
disagree!). Once a user can interact with the
interface in one application, that knowledge can
be applied in other applications designed using the
same widgets.

__________________________________________

Think List a number of GUI widgets that
are customisable in a common application
such as a word processor or spreadsheet.

__________________________________________

e —————
N

Some GUIs are designed for very specific
requirements, such as ATMs (Automated Telling
Machines), self-service checkouts and touch-screen
point-of-sale systems.



Operating system functions and
services

e System tools - the operating system often
contains a number of additional programs
called utilities, which are used to monitor and
maintain elements of the system. It is usually
necessary to keep the operating system patched.
A patch is a program that will fix a problem,
such as a software bug or a security issue,
or add extra features to improve usability or
performance. They are usually small programs,
but can in some cases be large. It is important
to keep the 0S patched to avoid viruses.

The operating system performs a number of vital
functions:

¢ TFile and disk management - the transfer of data
and program instructions from a backing storage
device to main memory and back again are
functions of the 0S. The 0S also enables users to
create folders and move, copy and delete files. It
keeps a database of where all the files are stored

so that they can be retrieved. Operating system software also helps to guard

¢ Memory management -the 0S manages the against security issues:

allocation of memory to programs, so that they e Logins and passwords - user IDs and passwords

can operate. Many operating systems can run
several programs at once, enabling users to
switch quickly from one program to another.
When a computer is booted, part of the 0S,
called the kernel, is loaded into main memory.
This sits in memory while the computer is
turned on.

User interface - the 0S provides an interface for
the user to interact with the operating system.
For example, in the Microsoft Windows® 0S,
users can use Windows Explorer to move files.
They can use the Control Panel to add and
remove programs and printers, optimise and
configure multimedia devices and much more.

Scheduling and peripheral management - the
0S assigns priorities for different operations
involving processor time. It also manages input
and output, using queues and buffers. Buffers
are required to store data temporarily as many
devices within the computer system operate at
different speeds. For example, data can be sent
to a printer faster than the printer can process
it, so data is stored in a buffer allowing the
printer to operate in the background and freeing
computer resources to get on with other tasks.

can be set on individual computers (a feature
of the 0S) or on networked computers (as part
of the network 0S). Network administrators can
set a minimum password length, set complexity
of the password and force users to change
passwords at regular intervals. They can also
control the areas of the network that users have
access to and on what days and times the user
can access the network. Rights to particular
files can also be set, for example read-only
access, read and write access, create new files
and folders and delete files and folders.

Encryption - this is the conversion of data
into a cipher with the aim of stopping the data
from being read by others. A key’ is required
to translate the data back into readable form.
There are a great many different methods of
encryption. To protect data from hackers,
private and public key systems are sometimes
used. These systems require two different keys
to be used. One key is used to encrypt the data
and another is used to decrypt it.

Audit logs - these can be used to record
information about activities on the network,
for example about who accesses data and when
they access it. Do they edit, copy, move or
delete data? Logs can be useful to track down
any unauthorised activity.



Device drivers

A device or software driver is a software program
that allows operating systems and other programs
to interact with a hardware device. One example
is printers’ drivers, which convert data to a format
that printers can understand. Drivers are specific
to certain operating systems and devices. If a
device does not function correctly, it is worth
going to the manufacturer’s website to see if there
are any newer drivers available for your model.
Other devices that need drivers are modems, CD-
ROMs, webcams and monitors.

SOFTWARE UTILITIES

Software utilities are programs that perform a
task or tasks that help to manage a computer
system. They are frequently, but not always, small
programs that are bundled with the operating
system.

Virus protection

It is important to protect computer systems from
virus attacks. The installation of scanning software
and a schedule of regular updating can reduce

the risk of a successful virus attack occurring. A
number of other actions can be taken by users to
reduce the risk of infection, including not opening
unsolicited email or attachments, avoiding pirated
software and backing up data regularly.

System profilers

This software can provide information about a
computer’s configuration and properties. It can be
used to display a list of all hardware and software,
including version numbers, on a computer. It can
also be used to assist in the detection of hardware
and software problems.
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Firewalls

A firewall is used to protect a network from
unwanted internet traffic. It exists between your
computer(s) and the internet. Some firewalls

are software programs that are installed on your
computer, others are built into hardware, such as a
broadband router. The firewall allows you to access
websites and download files while ensuring that
hackers cannot access your computer resources.

Clean up tools

¢ (Cookies and internet history - when web pages
are visited, copies of these files are stored
temporarily on the hard disk of your computer.
It is possible to control the amount of disk
space that is allocated to storing these files. A
list of pages and sites visited is also stored and
it is possible to set how many days this list is
kept for.

e Anti-spyware - spyware is software that is able
to collect personal information without the
user's knowledge. It may do this by recording
keystrokes made by the user, scanning
documents on the computer or recording
the Internet history. A number of software
applications can be installed to prevent the use
of spyware. Anti-spyware can also scan a system
for the presence of spyware and remove it.

¢ Defragmentation - as files are saved to a hard
drive, then edited, resaved, and deleted, parts
of a file may be saved to several different
physical locations on the hard disk. This
fragmentation of files leads to longer times
taken to read data into memory. Many operating
systems have a defragmentation utility, which
attempts to move files into contiguous sectors,
thereby reducing data access time.

rKeg words
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Cookie - a cookie is data that some internet sites
download onto your computer. In some cases a cookie
collects information about the websites you visit; in
others, it may contain auto-login information that
will enter your login and password automatically for a

Qvebsite you visit reqularly

J




Drive formatti ng On newer operating systems, such as Microsoft

Windows® XP, the format commands are run as
part of the 0S setup procedure. On older operating
systems such as Win95, the FORMAT command
would be run prior to the installation of the
operating system.

IT practitioners are usually only required to
perform high-level formatting of hard disks. The
disk is low-formatted at the factory to prepare the
surface of the disk for data and it is rare for this
procedure to be repeated. High-level formatting

might include: It should be noted that formatting a disk does not

mean that the data is irretrievable, although the

* scanning the disk for problems and marking bad pracess of recovering it is complex. If you need to

sectors
creating magnetic tracks and 512-byte sectors

creating areas between the sectors to keep error
correction information

creating a file allocation table to record the
location of files stored on the disk.

CASE STUDY: DATA-PRO LTD PART 2:
RESPONSIBILITIES

Software is installed using imaging or cloning
software to deploy standard builds. Different
builds are required to meet the software needs
of different departments and some departments
require more that one build. Additionally, each
different model of PC or laptop will require an
individual image to maintain hardware and
software compatibility, which means that bulk
purchases  new PCs and laptops are preferred
to reduce the need to create new images, which
take two days to complete.

An image is created by installing all software
and patches required onto a PC and then using
a utility provided by Microsoft called Sysprep

to remove the machine’s unique identity. The
imaging software is used to create a copy of this
PC. On image restore, the Microsoft setup wizard
automatically runs to recreate the PC’s unique
stripped (SID) identity. Once an image has been
created, a final machine configtration can be
completed in less than an hour. One-off custom
builds and server builds are always done from
scratch.

o .

___________________________________________________________________________________________

ensure that the data is gone forever, which you
may need to if the information is confidential
or financial, then you should either destroy the
hard drive or use a utility that has been created
specifically for that purpose.

SOFTWARE ‘

Quality control of work done is maintained using
checklists.

Requested one-off installations of software aTé
done manually.

A software licensing database is kept up to date.
This is done automatically via auditing software.
Reports are run manually every three months
and compared against licensing records. Any
unauthorised software found is removed. SpaPe
licenses are identified for future allocation.

Patching of software from Microsoft is achieved
automatically using Microsoft SUS server. Other
patches may be deployed manually or via group
policies.

Virus protection software is installed onto PCs
via login scripts. They run an agent that looks td
a central database on the network for updates.
The central database updates from the vendor's
site, thus minimising internet traffic.

o o o oo o P
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Evidence activity

P2 -M2 -P3 -P4

1, Questions have been asked about what
operating system should be used by the college.
Create a table with two columns that describes the
purpose, features and functions of two different
operating systems, such as Mac 0S, Unix® or
Microsoft Windows®. (P2)

2. Identify the differences and similarities
between the two operating systems and summarise
each one’s strengths and weaknesses in terms of
their features and functions. (M2)

3. Your line manager has asked you to create a
step-by-step guide to the use of two different
software utilities. The guide should include
screenshots of the steps taken to operate the
software. (P3)

4, There have been arguments in the department
about how to define a software utility. Describe

four different software utilities, including one from

each of the following categories: virus protection,
firewall, clean up and drive formatting. (P4)

Computer systerms

m Be able to undertake
routine computer
maintenance

SOFTWARE MAINTENANCE

Upgrade software

It is worth checking manufacturers’ websites for
the latest device drivers for installed peripheral
devices, such as graphics cards and printers. These
sometimes include bug fixes or provide improved
functionality.

It is vital to ensure that anti-virus protection
software is kept up-to-date to protect computers
from new viruses. It is usually possible to
configure the virus protection software so that it
automatically checks the anti-virus manufacturer’s
website every time the computer connects to the
internet and automatically downloads the latest
files.

Installation of patches

Many software companies release patches for their
programs. Because software programs can contain
millions of lines of code, it is almost inevitable

that there will be some errors in it. These errors, or

holes, can be exploited by rogue program writers.
To correct the errors, the operating system or
software manufacturer will issue a patch. Patches
are also released to add additional features to a
program. These can be downloaded from software
manufacturers’ websites. Microsoft Windows® XP
can be configured to automatically check for and
download updates. Instructions for the installation
of updates are usually supplied in a text file or on
the website.

.-

Microsoft has a number of different types of
patches, to deal with different issues. These include
‘critical updates’, which provide fixes for issues in
software; ‘feature packs’ which include additions

to software programs; and ‘driver updates’, which
update software that supports or controls hardware.

_____________
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Scheduling of maintenance tasks

Some organisations maintain a schedule of
preventative maintenance. This includes tasks to
be completed daily, weekly, monthly, six monthly
and annually, which might look like the example
shown below.

Table 2.4 A maintenance schedule
ﬁaily

* Check computer case
ventilation is not blocked.

L X R N L L L

* Check power cables are in
good condition

¢ Wipe over the exterior of
equipment with a damp cloth

¢ Check that anti-virus software
is updating correctly.

* C(lean inside the system case

CL Ty e Y

¢ Reseat any expansion cards
that are working loose

¢ (lean the keyboard and
mouse.

¢ Use a diagnostic package to
check system

* Scan the disk
¢ Defragment the hard drive.

e (Check warranties,

licensing.

Utility software aimed at users

Defragmentation
To defragment a disk in Microsoft Windows® XP:

> go to Start > All Programs > Accessories > Disk
Defragmenter

» or: click My Computer, then right-click on the
hard drive icon

> select Properties > Tools > Disk Defragmenter

» click the Defragment Now button.

¢ Backup data \

maintenance contracts andj

Clean up

To clear temporary internet files, cookies and
internet history on a computer, in IE7

» go to Tools > internet Options > Browser
History > Settings

» choose the settings you require
To clear temporary internet files in IE7:

» go the Tools menu > internet Options > Browser
History > Delete

» A number of options exist:
® temporary internet files
® cookies
¢ history
¢ form data

® passwords.

System Profilers

To access system hardware and software
information in Microsoft Windows® XP:

» go to Start > All Programs > Accessories >
System Tools > System Information

» the right-hand pane of the Information window
allows you to select the following information:
¢ hardware resources
e components
* software environment

¢ internet settings.

Other third-party utility software

Compression utilities

Compression software is used to reduce the size
of files for storage, download or for sending as
an email attachment. A popular format is .zip.

A software program is required to compress

the data and to uncompress it. A number of

free compression utilities are available on the
Internet, but Microsoft Windows® XP has its own
compression utility.



To compress a file or folder in Microsoft Windows®
XP:

> right-click on the file or folder and select Send
to

> choose Compressed (zipped) folder from the fly
out menu

» to unzip a file or folder in Windows XP, double-
click the zip file.

» click Extract all files.

Spyware Removal

A number of free software utilities are available
for download from the Internet. These can

be configured to detect and prevent spyware

from being downloaded onto your computer.
Alternatively, a program called Microsoft Windows®
Defender, a free download from Microsoft for
Win2000 and XP, can be used. It is built into Vista.

To scan your computer:
» start > All programs > Windows Defender
» click the down arrow next to Scan

» select Full Scan.

Diagnostic tools

Many software tools, some of which are free, can
be used to run a series of tests on your computer
to aid in the diagnosis of problems. An internet
search will find a number of these programs.

HARDWARE MAINTENANCE

It is usually preferable for computer equipment to
be stored off the floor. Carpet and dust can reduce
the flow of air around the computer case, which
can lead to the temperature within the case being
hotter than desirable, which will shorten the life
of the computer.

The computer case should always be kept closed
when in operation. The fans inside the case are
designed and positioned to maximise cooling of
the components.

Computer systems

.

There are many companies that offer professional
computer cleaning sevices.

Capital Computer Care offers cleaning services of
equipment including desktops, laptops, printers and
scanners. Their clients range from small businesses
to major national organisations.

______________

__________________________________________

Think Why might some businesses choose
to employ professional computer cleaning
services?

e ————
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__________________________________________

Cleaning equipment

To avoid problems developing with a computer
system, you should take preventative measures.
This can be as simple as having a simple cleaning
regime. Computer systems attract dust and dirt,
which shorten their efficiency and life. It is
important that the right products and methods

are used when cleaning to avoid damage. A range
of products will need to be used, including soft
cloths, screen wipes, anti-static spray, a small
paintbrush, compressed air (usually in an aerosol),
a vacuum cleaner (special attachments such as fine
crevice tools can be purchased), cotton swabs, flat-
headed and Philips screwdrivers and a grounding
strap.

A Always check manufacturer’s instructions
for cleaning their equipment and ensure that
the computer is unplugged before undertaking
cleaning.

¢ Computer cases - use soapy water on a squeezed
soft, clean cloth. Ensure that no excess moisture
is able to penetrate into the case.

¢ Computer screens - avoid the use of solvents
as they may cause discolouration. Screen wipes
are useful for removing general dust and finger
marks, Anti-static spray may be applied.

e ————



Keyboards - the keyboard should be unplugged,
then turned upside down to shake out loose
dust or crumbs. A vacuum can also be used.

To loosen a sticky key, use a flat-headed
screwdriver to gently remove the key. Clean the
key socket as well as possible (using computer
cleaner or distilled water), then, when dry, snap
the key back in place.

¢ Mouse - the inside can become clogged with
dust. Unplug the mouse, remove the cover and
release the mouse ball. A damp cloth can be
used to clean the ball. Three rotlers are located
inside the mouse. Dust will need to be removed
from them, using a pair of tweezers or your
fingernails.

¢ Inside the computer case - only compressed
air should be used to clear dust. It is extremely
easy for static electricity to permanently
damage the inside of a computer, so avoid
touching any components in the process.

® Inkjet printers - these are prone to developing
clogged nozzles, especially when the printer
has not been used for some time and the ink
dries. Most printers have an automatic cleaning
program, which may need to be run a couple of
times to clear the nozzle. Many manufacturers
advise against manually cleaning the printer
heads.

o Laser printers - general dust and bits of paper
can cause poor print quality and paper jams.
Check the printer manual and warranty before
cleaning. Turn off the printer, unplug it and
allow it to cool down first. Remove the toner
cartridge and use compressed air to remove dust
and general debris. Use a disposable soft cloth
to remove residual toner from the inside of the
printer.

Install and configure new peripherals

IT practitioners may be called upon to install new
computer devices, particularly printers. Most new

printers come with manuals and installer programs.

If so, you should always read the documentation
for any special instructions. You will probably
need to install toner or ink-jet cartridges and you
should follow the instructions on the packaging.

If instructions aren’t available, the following
procedures can be used:

USB printers

» if you have an installation program, install the
printer drivers before you connect the printer
to the computer. Follow the instructions given

» if you do not have an installation program,
attach the USB cable to the computer and
printer, The ‘Add New Hardware’ window should
appear on your screen

» click next, then click ‘Search for the best driver
for your device' Click Next again

> browse to locate your printer drivers, then click
0K

» click Next a further two times and then click
Finish

» turn on your printer and print a test page.

Parallel port Printers (Microsoft Windows® XP)
» go to Start > Printers and Faxes > Add Printer

» select Local printer OR Printer connected to
this computer, then click Next

» select the LPT port and the make and model of
printer

» otherwise, click Have disk, and browse to the
location of the driver

» click Open, then OK

» select Yes to make the printer the default printer,
then select Do not share this printer, then Next

» turn the printer on, then print a test page by
selecting Yes. When the page has printed, click
Finish.

Install and configure additional or
replacement device

You need to be able to install or upgrade a hard
drive, graphics card, optical drive or a network
interface card.

A\ Remember to always turn off the computer
and unplug from the mains before opening the
computer case, Use a grounding strap when
touching components within the case.



Replacing a hard drive

Hard drives are mechanical devices, and therefore may
fail, necessitating a replacement. Alternatively, a user
may find that the disk is no longer large enough to
store all their programs or data in which case a new
hard drive will be needed. Replacing a hard drive may
be a way of extending the working life of a computer.

To replace an IDE drive:

» backup any data you will want to copy to yowr
new disk

» turn off the computer. Unplug the power lead

» remove the old drive. Note where cables
connect to power supply and the motherboard

» set the jumpers for master, slave or cable,
Select the replacement hard drive. Check the
original drive settings, and do the same

» install the drive in the mounting frame, reusing
the screws from the previous drive

» attach the cables to the motherboard and to
the power supply

» most modern BIOSs will auto-detect the new
hard drive. If not, go into the BIOS to change
the drive settings.

Installing a sound card

» install the card into a free slot. Avoid touching
the components on the card. Ensure that the
card seats itself firmly

» connect the cable from the CD/DVD drive to the
soundcard

» screw the card in place, if a screw hole exists
on the card

» close the case and reattach the keyboard,
mouse, monitor, speakers, etc

» on startup, Microsoft Windows® should
recognise the soundcard. Follow the onscreen
instructions to install software drivers.

Upgrading a graphics card

» Uninstall existing card drivers.
» Remove card.

» Install new card.

» Install new drivers.
>

Configure display settings.

Adding a CD/DVD drive
» remove the drive slot cover on the case.

» set the IDE drive mode to Master if it is the
only device attached to the cable.

» install the drive in the case,

» attach the audio cable to the drive. The other
end of the cable attaches to the motherboard or
a PC audio card.

» attach the IDE cable into the motherboard and
one of the other connectors of the cable into
the CD/DVD drive.

» insert a 4-pin molex connector from the power
supply into the CD/DVD drive.

Key words

4-pin molex connector - a commonly used power
connector for disk drives and other components

Adding and configuring a Network
Interface Card

If you wish to attach your computer to a local area
network (LAN), a network interface card (NIC) will
need to be installed unless the computer already
has onboard networking. The user manual that
comes with the card contains vital information
related to installing and configuring the NIC.

» Ensure that the card has connectors that are
compatible with the cabling used by the
network. Many Ethernet cards come with both
BNC and RJ45 connectors so that they will work
with both thin Ethernet and CAT5, CAT5e
cabling.

» Check the User Manual to determine the
required jumper settings

» Install the card into an expansion slot on the
motherboard of the computer. Secure it to the
back plate of the computer using a screw

» Microsoft Windows® XP should detect the
card and load the drivers, otherwise install
drivers when prompted. Install the NIC drivers
onto your computer. This software allows the
computer to manage communication between
itself and the NIC




» some NICs have activity lights that can be used
to help diagnose problems. See the user manual
that came with the card

» attach the network cable to the connector on
the NIC

» find out what protocols are being used (from
the network administrator). Assuming it is
TCP/IP, today's prevalent protocol, IP numbers
will either be static or dynamically allocated
by DCHP. In case of the former, contact your
system administrator for the correct IP number,
subnet mask, DNS setting, WINS settings, and
domain suffix and gateway settings to be used

» go into Control Panel > Network Connections

» double-click on the TCP/IP protocol, then add
the appropriate settings.

Unplug computer equipment during
thunderstorms whenever possible, including
modems.

¢ Ensure that cooling vents on computer cases are
not blocked and unable to dissipate heat from
the processor and other components.

Electrical computer equipment in the workplace
needs to be PA (Portable Appliance) tested

as part of statutory Health and Safety
requirements. The frequency of testing is set by
the Health and Safety Executive.

Care also needs to be taken when working with
laser printers. There are a number of hazards to
consider:

there are a number of high voltage areas within
laser printers

o the light produced by the laser can damage

Key words

DCHP - Dynamic Host Configuration Protocol. A set of
rules to allow a computer to request and obtain an IP
address

eyesight

you should always unplug the printer and
allow it to cool for a few minutes, due to high

Other hardware maintenance issues
Health and Safety

When working with computer equipment, there are
a number of hazards to be aware of.

e Never open the power supply or VDU (monitor)
units as there is the potential for receiving a
life-threatening electric shock due to extremely
high-level voltages.

Avoid working inside the computer case while it
is plugged in and switched on.

¢ Keep food and drink away from computers.
When cleaning around the computer with fluids,
be very careful to avoid fluid dripping on or
seeping into the equipment.

Regularly check that the insulation on power
cables is in good condition and replace them
if necessary. Ensure that power cables are not
trapped under pieces of furniture or left where
they can become trip hazards.

temperatures produced by the fuser unit

you should not attempt to bypass interlock
switches inside a laser printer without expert
training.

Disposal of Equipment

Computer equipment contains some
environmentally hazardous materials, such as

lead, arsenic, precious metals and plastics. The

EC Directive on Waste Electrical and Electronic
Equipment (WEEE) aims to minimise the impact of
electrical and electronic items on the environment.
From 1 July 2007, producers of any equipment
bought after 13 August 2005, will be responsible
for collecting and disposing of it. Where equipment
was purchased prior to 13 August 2005, it is the
responsibility of the business to pay for it to be
recycled or disposed of.



FILE MANAGEMENT

Create folders

Learning to manage files is an important element
of computer maintenance. It is frequently
necessary to create folders, copy, move and delete
files and there are a number of different ways of
managing this. Microsoft Windows® XP uses File
Explorer for this purpose.

If you are in school or college, you may not be able
to access File Explorer, or its functionality may be
reduced. This means that you may need to develop
alternative strategies for managing your files and
folders.

To open File Explorer
» right-mouse click on the Start button > Explore

» the File Explorer screen usually displays two
panes, The left pane shows a list of drives and
folders, while the right pane displays the contents
of a selected folder. If a folder has a sub-folder
within it, a plus or minus sign will appear next to
it. Clicking on a plus causes the contents of the
selected folder to display in the right pane

» to open a folder, click on it

» clicking on a minus causes the contents of the
folder to be hidden. It closes the folder.

To create a folder

» in the left pane, click on the drive or folder in
which you wish to create the folder

» go to the File menu > select New > Folder

» type in a name for the folder. Press Enter. You
should not use any of the following characters
when naming files or folders: *<>[J=+"\ 7,

To select a block of files

» display them in a list, click on the first file in
the list, hold down the shift key, then click the
last file in the list.

To select files that are not in a contiguous
list
select the first file, hold down the Control key,
select each of the required files.

To copy and move files

» with your file or files selected, Ctrl+C will copy
the files into the Windows clipboard

» ctrl+X, will move files onto the clipboard

» browse to the required folder, then Ctrl+V to
paste.

To delete files
» once they are selected, press the delete key.

Backup procedures

It is a common role for IT practitioners to be
responsible for ensuring that valuable computer data
is backed up regularly. If data is added or amended
daily, it may be necessary to back this up daily.
However, certain types of data may only be amended
periodically and may not need backing up as often.
For example, if payroll is processed monthly, it may
only be necessary to back this data up once a month,
after the payroll has been run.

A number of different devices may be used for
backing up data, including floppy disks, CD-ROM,
DVD, external or alternative hard drive, ZIP drive
or tape drive. Some devices will be appropriate for
small amounts of data; some systems may need to
backup very large amounts of data.

There are three main types of backup procedures.

¢ Full backup - This backs up everything on the
system.

¢ Incremental backup - This backs up only files
that have changed since the last backup. The
archive attribute is updated. This will be quicker
and takes up less storage space than doing a
full backup each day. It allows data produced or
changed on a specific day to be restored. If a full
restore is needed, and the last full backup was
done three days ago, the backup followed by the
three incremental backups would need to be used
to restore the system. The files changed since the
last incremental backup would be lost.

Key words

Archive attribute - the archive attribute indicates
whether a file has been updated since the last backup.
When a file is created or changed, the bit is turned on;
when the file is backed up, the bit is turned off
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MAINTENANCE RESPONSIBILITIES

When a piece of equipment comes into the
department for work it is given a surface and
internal clean before being returned.

Backups are taken every night of all servers

and data areas. A full backup is taken on a
Friday night. This takes approximately 15 hours
to complete and spans multiple tapes. These

are autoloaded using a robotic tape device.
Incremental backups are taken on weekdays.
These complete in eight hours. A 30-day cycle is
used, with tapes being sent off site for storage
every day.

The team is involved in a yearly BCP test
(Business Continuity Plan). The company pays
for floor space and hardware in a DR (disaster
recovery) centre located in a different part of
the country. Once a year, all systems, including
desktops, servers, and network connectivity, are
implemented according to the plan using only
backups and pre-supplied machine images to
emulate a loss of site. This process takes three
days.

The team are responsible for day-to-day
administration, such as setting up user accounts
and logins, maintaining group memberships

for email and security, granting of access to
server areas, general maintenance of user
details, password resets, account lockouts and
account deletion. They are also responsible for
the procurement and installation of printers,
configuring network printers, user access to the
printers and management of repair calls under
warranty and post-warranty. Laser printers are
not repaired by the team due to the hazardous
nature of the equipment.

The team:

e is responsible for keeping an inventory of all
PCs, laptops, printers, scanners and servers

® e oy S -

¢ set up training and meeting rooms with any
PC-connected equipment that is required

- is responsible for reporting IT-related risks to
management. Identified risks are added to a
risk database

¢ is responsible for the procurement or
maintenance agreements on software and
hardware where required

¢ supply a limited amount of user support for
software, Generally, training is dealt with by
the HR department

® maintain a knowledge base of unusual and
reoccurring issues and pracedures.

A third-party company comes in to clean the
computer equipment. This is done overnight, The
company use specialist cleaning materials.

Disposal of old and broken equipment is also
handled by a third-party company.




¢ Differential backup - This creates a cumulative
backup of modified files only. The archive
attribute is not updated. This method is useful
when only the latest version of an altered file is
needed.

-

There is a growing market for data storage. Sun
Microsystems, a US-based software and computer
server maker, bought a data storage firm called
Storagetek for £2.3 billion in 2003. Whereas Sun
produces primary data storage systems, Storagetek
provides secodary storage services, e.g. data
archiving and back-up systems. Sun’s move into the
market reflects a growing recognition by businesses
of the potential threat posed by data loss, and the
need to put in safeguards to minimise the risk.

Even though there is an increased awareness of the
need to manage risk, computer failures can still
cause massive disruption for businesses and other
organisations. In July 2007, there were severe flight
delays on US East Coast routes when the computer
system that manages part of the air traffic control
system failed. When the back up computer became
overloaded, flight controllers were forced to enter
information manually, resulting in lengthy delays. ;

-

Evidence activity

P5 - M3 - M1 - D2

1. Identify the maintenance activities that are
needed for a PC. Produce a checklist (plan) for
each activity. Carry out each maintenance task,
take photographs as evidence and/or obtain signed
observation sheets. (P5)

2. Explain how the activities you carried out
for P5 have improved the performance of the
computer. (M3)

3. Install and configure a printer and one of the
following: a hard drive, graphics card, sound card,
CD-ROM drive or a network interface card. Produce
supporting notes, explaining the process you
followed, to show understanding. (M1)

4, In a short report, justify the considerations for
selection of your upgrade. (D2)






